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1 Introduction

1.1 About Log Monitor & Export

The term "log monitor" is a general term referring to different programs that all perform automated
monitoring of various kinds, keeping track of changes to a file or file system. This is especially useful
for administrators who have to stay on top of a large network consisting of databases, file systems,
and many different programs running all at once. Even for single computer users, these monitoring
programs can prove useful to provide a high level of control over an operating system’s activities.

Our log monitor also comes with built-in notification or even scripting capabilities. That is, in the
case that anything remarkable is found in any of the logs that the program is currently monitoring, it
could simply send off an email to the human administrator, or even perform a preprogrammed
response. This saves administrators a lot of tedious labor in looking through many different logs, and
frees their time for more important and complex administration tasks.

Key features of Log Monitor & Export:
capability to monitor multiple log file at the same time. Each log may have fully different monitoring
and exporting settings;
allows monitor local and remote log files;
real-time or schedules optimized monitoring;
supports different log text or binary types;
supports date/time stamping; 
allows to archive and pack log files;
can send notification via email, ICQ and several other method;
data export to ready-to-use Microsoft Excel, Microsoft Word (RTF) or Adobe PDF files; 
data export to most popular databases (MSSQL, Oracle, Interbase, etc.);
simple, menu-driven step by step set-up - programming is not required to configure the software to
collect data; 
many plug-in modules that extending program features;
Supporting various operating systems. It runs under all versions starting from Windows 2000,
including 32 and 64-bit systems.. 

Unlike most other log monitoring applications, Log Monitor & Export can run as a service so that it
starts as soon as the operating system starts and doesn't require a user to log in and run it. It will
continue to run even as users logon and logoff the workstation. 

It is extremely easy to use! The configuration process is fully menu driven and has complete,
context sensitive, on-line help. you can easily customize all input to your exact specifications. Once
you see how easy it is to use Log Monitor & Export, you will never again take data readings by
hand!

Typical usage

A good example of a case wherein a monitoring program can save an administrator a lot of hassle is
with a large file system open to many users. Keeping track of directory changes, new files, file name
changes, and so on would be nearly impossible without using a specialized program designed to do
so. By setting a few basic rules, for instance, restricting file types to particular folders, or restricting
access to certain directories, an administrator can keep the entire system in tip-top shape.
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Applications examples

Data logging systems;
Remote control systems;
Alarm systems;
Web or data servers monitoring.

Company home page: http://www.aggsoft.com/
Software home page: http://www.aggsoft.com/log-monitor.htm

1.2 Glossary

ASCII - An acronym for American Standard Code for Information Interchange. ASCII files are plain,
unformatted text files that are understood by virtually any computer. Windows Notepad and virtually
any word processor can read and create ASCII files. ASCII files usually have the extension .TXT (e.
g., README.TXT).

Binary File - A file that contains data or program instructions written in ASCII and extended ASCII
characters. 

Bit - Binary digit in the binary numbering system. Its value can be 0 or 1. In an 8-bit character
scheme, it takes 8 bits to make a byte (character) of data. 

Bytes - A collection of eight bits that represent a character, letter or punctuation mark.

Cable - Transmission medium of copper wire or optical fiber wrapped in a protective cover.

Client/Server - A networking system in which one or more file servers (Server) provide services;
such as network management, application and centralized data storage for workstations (Clients). 

PC - abbreviation for a Personal Computer.

Ports - A connection point for a cable.

Protocol -A formal description of a set of rules and conventions that govern how devices on a
network exchange information. 

http://www.aggsoft.com/
http://www.aggsoft.com/log-monitor.htm
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2 License, Registration and technical support

2.1 License

Copyright © 1999-2016 AGG Software.
All Rights Reserved

SOFTWARE LICENSE

Trial Limited Version

The trial limited version of this software may be used for evaluation purposes at the user's own risk
for a trial period. At the end of the trial period, the user must either purchase a license to continue
using the software, or remove it from his/her system.

The trial limited version may be freely distributed, provided the distribution package is not modified.
No person or company may charge a fee for the distribution of Log Monitor & Export without written
permission from the copyright holder. 

Licensed Version

  On payment of the appropriate license fee, the user is granted a non-exclusive license to use Log
Monitor & Export on one computer (i.e. a single CPU), for any legal purpose, at a time. The
registered software may not be rented or leased, but may be permanently transferred, if the person
receiving it agrees to terms of this license. If the software is an update, the transfer must include the
update and all previous versions. 

  Registered customer are entitled to free updates during one year from the date of purchase. It
means that during one year you can download and install the latest registered versions of Log
Monitor & Export from our site. If you don't want to purchase an updates, you can use the program
forever; it will never expire, but you won't be able to use the latest version. If you purchased the
software more than one year ago, you are no longer entitled to free upgrade and technical support;
however, you can purchase an updates to the latest version at a special, greatly discounted price,
and this updates will allow you to have free updates and technical support for another year. The type
of update license must match the type of your existing license.

  Whilst every care has been taken in the construction and testing of this software, it is supplied
subject to the condition that the user undertakes to evaluate the suitability of the control for his/her
purposes. AGG Software makes no representation of the software's suitability for any purpose, and
the user agrees that AGG Software has no responsibility for any loss or damage occasioned by the
use of this software.

  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE AND
DOCUMENTATION ARE PROVIDED "AS IS" AND AGG SOFTWARE DISCLAIMS ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, CONFORMANCE WITH DESCRIPTION, TITLE AND NON-INFRINGEMENT OF THIRD
PARTY RIGHTS. 
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  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AGG
SOFTWARE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
EXEMPLARY DAMAGES OR LOST PROFITS WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF
THE USE OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF AGG SOFTWARE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, AGG SOFTWARE'S
CUMULATIVE AND ENTIRE LIABILITY TO YOU OR ANY OTHER PARTY FOR ANY LOSS OR
DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING OUT OF OR
RELATING TO THIS AGREEMENT SHALL NOT EXCEED THE PURCHASE PRICE PAID FOR
THIS LICENSE.

  Should any term of these terms and conditions be declared void or unenforceable by any court of
competent jurisdiction, such declaration shall have no effect on the remaining terms hereof. 

  If you do not agree to these conditions you should not install this software.

2.2 Limitations

Program is distributed on shareware terms. This means limited and unavailable secondary program
possibilities, which become valuable or available after program registration. To register the program
read here .
In trial version of our program are the following limits: 

 Trial period is limited by 21 days. After that time program won't work until it is registered.
 Continuous program work time is limited. After set period a message will be displayed and
program stops its work;
 All data export modules can handle first 100 records only;

2.3 How to register

The program is distributed on shareware terms. This signifies limited or unavailable many features of
the program, getting of full value or available after program registration.

If you'd like to be a registered user, to get information about the release of new versions, to use
technical support and, at last, to get access to disabled functions of the program, register your
copy. For registration, please, read license agreement . 

If you want to buy a program through the Internet visit the registration page of our site. On this page
you can get the newest information about the registration process, and also find an order link. After
you've have the form of order registration. Enter your personal information and choose the most
convenient payment method for you. Further, you'll get notification and follow the notes in it.

More information about services, registration documents, payment means you can get on our 
registration page of our site.

4

3

http://www.aggsoft.com/order/
http://www.aggsoft.com/order/


5License, Registration and technical support

© 1999-2016 AGG Software

2.4 Support

Technical questions support@aggsoft.com

Common questions info@aggsoft.com

Sales questions sales@aggsoft.com

3 Installation

3.1 System requirements

Windows 2000 Professional - Windowsa 8.1, including x64 and x86 OS, Workstation and Server
OS.

It is necessary to have at least one working network interface (card) in your PC.

3.2 Installation process

If any beta-version was installed on your computer, remove it.

Quit of the working Log Monitor & Export on installation time.

Run an installation file.

By default, Log Monitor & Export will be installed to the directory "/Programs Files/Log Monitor &
Export" of your system disk, but you can change this path.

In the standard distributive of Log Monitor & Export are no additional modules files, which you can
download from our site.

4 Program use

4.1 Getting started

After you have successfully installed Log Monitor & Export, use the following simple steps to
configure and run it.

Open the Log Monitor & Export program from the Start Menu. 

mailto:support@aggsoft.com
mailto:info@aggsoft.com
mailto:sales@aggsoft.com
http://www.aggsoft.com/
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At program run you get into the main program window (fig. 1.1.1), main elements of which are the
main menu, the data window, the program messages list and the status bar. In the data window will
be viewed formatted data processig. In the messages list are logged information, warning and error
messages. The status bar shows current state of the selected data source, interface error
messages and a number of bytes processed. Through the main menu, placed above the data
window, you can get access to program settings  ("Options/Program settings...") and from the
menu "File" (fig. 1.1.2) can open an current log-file or clean the data window.

Fig. 1.1.1 Main program window

Fig. 1.1.2. "File" menu item

By default (after installation), the program has not any data sources configured. If the list of data
sources on the toolbar is empty, then the program will ask you to add new configuration. Otherwise,
the program will fill in the list of data sources and try to start logging of data sources configured.
Yes, of course, all your settings are being saved while exiting from the program and loaded while the
program start.

Set-Up is as Easy as 1-2-3

Step 1. Configure one or more data sources.

7
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Click the "Add configuration" button on the toolbar with big green plus and choose log files. The
"Files and folders" tab of the "Configuration options" dialog lets you configure your settings.

Step 2. Configure log file.

Select the "Log file" header in the configuration dialog window and enable logging.

Step 3. Define how you want the log files data to be parsed and translated .

The "Plug-in" button on the toolbar in the main window or "Modules" tab in the dialog window lets
you specify how to parse, filter and format your data to the fit the exact format required by your
application. It also lets you pre-define automatic output strings to be sent to an external device. 

Now, the program process and exports data from one or multiple data sources.

4.2 Introduction

Log Monitor & Export can save data to a log file(s) without any changes (i.e. create raw binary log
files) or write to log files depending on the parser module selected. In the first case you can view the
log file with any hex editor and  use this data for further analysis and remaking. In the second case
you can view data with any text editor. You can find more information about log files in the "Log
rotation " chapter. 

You can watch the data in the data window (fig. 1.1.1 ). The data view is fully customizable. You
can watch data in decimal, hexadecimal or your own format. How to customize data view you can
read in the "Data view " chapter and how to customize program view you can read in the "Window
view " chapter.

The data can be exported or transferred to one or more targets. Most simple way is to configure the
log file rotation. But it is small part of all features of Log Monitor & Export. Log Monitor & Export has
many additional modules  (so-called plug-ins), that are appreciably extending possibilities of the
logging software. You can download and install any module supported. Most modules are free of
charge for our customers. How to install and configure modules you can read in the "Modules "
chapter.

The program and their plug-ins generates many messages and writes they to the list in the main
window (fig. 1.1.1 ) and a protocol file, that you can use for administration of the software. You
can configure types of system messages. More information about it you can read in the "Protocol
and errors handling " chapter.

25

21
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4.3 Data flow diagram

This diagram may help you to understand the flow of data within our software and a place of each
module. All modules are described in following chapters.

Fig. 1.2.1 Data flow diagram

History:

        - Binary flow of data (RAW, unformatted data).

        - Parsed data (formatted data). The data flow was been separated to data packets and
variables. Each data packet can be interpreted as a row, and each variable can be interpreted as a
column.

Wires with other colors mark other relations with unstructured data flow.
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4.4 Work complete

After program work stop all program settings will be saved in Windows registry. Opened for reading/
writing data sources will be automatically closed and will be available for other applications.

4.5 Useful advices

1. Look through hint helps on all window elements - this will help you to get a picture of this
element's function. 

2. You can change all program settings without restarting the program. To transfer settings to
another computer you can do the following:

1. Create a configuration backup from the "File" menu and restore it using the same menu.
2. Or export the registry node with all program settings. Start regedit.exe and export the following

registry node:

on Windows x64 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\AGG Software\Log Monitor & Export

on Windows x32
HKEY_LOCAL_MACHINE\SOFTWARE\AGG Software\Log Monitor & Export

3. On another computer import settings to the Windows registry.

Many main window elements have "hot" keys for quick access to its functions.
Ctrl+S - analogues to click on "Start/Pause" button on toolbar.
Ctrl+C - analogues to click on "Clear" button on toolbar.
Ctrl+P - call options window with configuration settings.
Ctrl+L - call options window with log file settings.
With Ctrl+W hot key You can configure window view.
Ctrl+R - show window with program's restart settings.
Ctrl+E - Windows NT/2000/XP service settings is available here.
Ctrl+M - here you can configure queries, parsers and other modules.

4. You can look at the summary statistic that contains summary about sent and received data,
created files etc (View - Statistics)

5. You can save program settings to an INI file. It may help to install and use several copies of the
program. You can make your choice from the "Options" menu.

6. The program window can display only last 10 message. The full program log file (if activated) you
can open using the "File - View program protocol file" menu item.
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4.6 Configuration

4.6.1 File settings
4.6.1.1 File data source

About log files

A log file is a file containing records about events in the chronological order.

Logging means the chronological recording of data with varied (customizable) level of details about
systems events (errors, warnings, messages). Usually, the data is saved to a file.

Examining the contents of an error log file after failures often makes it possible to understand what
causes them. Old hardware and software systems use log files to save and store data.

Purpose

The program is used to monitor folders (directories) with log files or separate log files in real time.
Once the program detects new data in the log file, it can send notifications to the administrator or
export and archive data from log files. The built-in script and filter tools allow you to single out only
the events you are interested in from one or several log files. It considerably decreases the load on
the administrator whose job is to maintain several web servers or data servers.

A good example of how to use the program is monitoring a computer where a lot of users can
create, copy and edit a file. Log files allow you to track all changes and the administrator can control
all operations using the log file. With our program, the administrator can create event types that are
to be detected (for example, deleting a file or creating a file with a certain name) and receive an
immediate notification about this event as a desktop or e-mail message. The program becomes even
more useful if you need to control several servers simultaneously.

How the program works

Once started, the program analyzes the list of folders specified in the configuration checking if these
folders exist. If a folder exists, it is added to the scan list, otherwise it is skipped. Once the data
source is started, the file list is also filled with the initial file size values. Then the program is
switched into one of the scan modes specified in the configuration:

1. "Simple" – simple scan mode. In this mode, the program just analyzes the folders and subfolders
specified in the configuration for changes in the file.

2. "Shell" – the shell mode uses operating system events when files and folders are created or
modified.

If the program is configured to read data at startup, after the initial processing it will read data from
the files of the corresponding folders and subfolders and prepare this data for exporting, archiving or
sending notifications.

The program monitors new files and folders and starts processing them in both modes. The program
also monitors deleted files and folders and stops processing them.

If a file has just been created or the size of an existing file has changed, the program reads this data
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from the file and passes them on for further processing. The parameters specified in the configuration
are used to read data (see "File settings"). If there is a delay set in the configuration before reading
the file and the file changes during this delay, the program delays reading the file for the time of the
delay specified in the configuration. If the file changes again, the reading will be delayed again and
so on till the file stops changing. After the program reads the file, it performs one of the following
three operations with it:

1. The file is deleted;
2. The file is cleared, i.e. the file size becomes equal to zero;
3. The file is not modified.

The program takes into account the file mask specified in the configuration, i.e. if "*.txt" is specified
in the configuration, the program will scan and read data only from text file – it will ignore all other
files. The program also uses the minimum file size value from the configuration during the scanning
process. If the file size is less than the specified value, the program does not read the file till the file
size is equal to or larger than the specified value.

The program reads data from the file by blocks whose size is specified in the configuration. The
larger the block is, the fewer times the program accesses the disk and the better the performance
is, but the requirements to the computer performance are higher.
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4.6.1.2 Folders settings

Select the "Folders" tab in the "Configuration options" window and you will see the list of folders on
the screen (fig. 2.6.1).

Fig. 2.6.1 Folders settings

Data source name – the field contains any name that will denote the operations performed with
files. You will see this name in the drop-down list in the main window of the program. By default, it is
Data source #XXX, where XXX is the number of the data source.

By default, the list of folders for scanning is empty. Click the "Action" button or right-click the empty
list and you will see the action menu (fig. 2.6.2).
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Fig. 2.6.2 Action menu

Add... - the item allows you to add a new folder to the list. After you select this item, you will see
the Folder Properties dialog box on the screen (fig. 2.6.3). Specify the folder properties, click the OK
button and the folder will appear in the list. If you change your mind, click Cancel.

Delete - the item removes the selected folder. Before the deletion, the confirmation dialog box will
be displayed on the screen when you will have to click Yes to remove the folder from the list or No to
cancel the operation. The item is not available if the list is empty.

Edit... – the item shows the "Folder properties" dialog box (fig. 2.6.3). Change the folder properties
and click OK to save them. If you change your mind, click Cancel. The item is not available if the list
is empty.

Up - the item moves the folder one position up. The item is not available when the list is empty or
when the first folder is selected.

Down - the item moves the folder one position down. The item is not available when the list is empty
or when the last folder is selected.

Fig. 2.6.3 Folder properties

Path - the field contains the path to the folder. You can select the folder from the list by pressing the
button to the right. The default folder is the current one.

Subfolders - the checkbox enables/disables scanning subfolders. By default, subfolders are
scanned.
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Depth - the depth of scanning subfolders. 9999 by default.

Note: The scanning depth is counted from the specified path to the folder. For example:
C:\Files\Data\Test - source folder
C:\Files\Data\Test\Folder0 - level 1
C:\Files\Data\Test\Folder0\Folder1 - level 2
etc.

Note: If the specified folder does not exist, you will see an error message on the screen and you will
not be able to save the folder properties so it is recommended to select folder from the list by
clicking the button to the right from the Path field.

4.6.1.3 Files settings

Select the "Read options" tab in the "Configuration options" window and you will see the file and
scan settings on the screen (fig. 2.6.4).

Fig. 2.6.4 Shell mode

Scan mode - the list allows you to select one of the scan modes: Simple or Shell. In the Simple
mode, the program just goes through files in the specified folders and subfolders and checks if the
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the file size has changed. The Shell mode uses operating system events to check changes in the
file size. The program monitors new files and folders and deleted files and folders in both modes. If
the operating system does not support the Shell mode, only the Simple mode will be available in the
list. The default mode is Shell.

Shell mode

File mask - the field contains the file mask used to scan files. The program processes only those
files that match the mask. For example: *.* - all files are processed, *.txt - only text files are
processed, *.exe - only executable files are processed. The default is *.*.

Block size (bytes) - the field contains the size of the block (in pixels) used to read data. If the size
is too small, Data will be read multiple times from the file, which will result in a delay. If the size is
too large, it may also result in a delay. Choose the optimal data block size. The default is 512 bytes.

Min file size - the field defines the minimum size of a file to be processed. There is a list to the right
from this field. It contains measurement units: Byte(s), KByte(s) and MByte(s). If the size of the file
is less than that specified in the field with the corresponding measurement unit, it is not processed.
The default is 1 Byte(s).

Time after change (msec) - the field contains the delay before the file is read. If the file changes
again during the delay, the reading will be delayed again and so on till the file stops changing. The
default is 500 msec.

Read data on start - the checkbox allows the program to read data from the file and pass them to
the kernel at the program startup. The above parameters are used to read data. It is disabled by
default.

Read and delete - if the option is selected, the program will delete the file after the data is read. It
is not selected by default.

Read and truncate - if the option is selected, the program will clear the file so that its size equals
zero after the data is read. It is not selected by default.

Read and don't change - if this option is selected, the program will leave the file unchanged after
the data is read. It is selected by default.

Simple mode

All parameters are the same as for the Shell mode except for the last option.

Scan interval (sec) - the field contains the scan interval value. The default is 30 sec.
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4.6.1.4 Schedule

Select the "Schedule" tab in the Configuration Options window and you will see the log file scan
schedule settings on the screen (fig. 2.6.5).

Fig. 2.6.5 Schedule

These options allows you to specify:
1. The days to scan on (the "Days of week" group);
2. The time when to scan (the "Time of day" group). If you specify the interval as 0:00:00-0:00:00,

scanning will be done around the clock.

These options can be useful if, for example, you do not want to scan log files at weekends when the
computer is off or when the administrator will not see notifications anyway.
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4.6.2 Additional parameters
4.6.2.1 Data view change

Fig. 3.1.1. Data view

Data view settings, that can be configured on the "Data view" tab:

1. View characters with code - the program can interpret and decode bytes as characters. You
can select decoding mode for each characters range. If the range doesn't have the
corresponding character, that's why these data can be displayed only in hexadecimal and
decimal code.

2. You can set up data  byte display users format. The directive %d shows to display an decimal
code, the directive %x  - hex code. You can set any framing characters before/after the user
format.

3. Highlight data sent on screen - string with sent data will be highlighted by the set color.
4. Character set - allows to define the character set of incoming data. Windows - Windows ANSI

character set, DOS - OEM character set.
5. Data source custom color - if you've created several configurations then you can define a

custom color for each data source that allows to distinguish data flows on the "All data" page in
the main window.

6. Split strings by data timeout - this option allows to visually split data packets in the program
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window. A data packets that will be received after the specified interval will be showed on a new
line. If this value is set to 0 then data packets will not split.

7. Split continuous data blocks large than - this option allows to visually split continuous data
flow in the program window. The program will show data from a new line every specified interval.

8. Split by characters - this option allows to visually split continuous data flow in the program
window using the specified symbols. For example (fig. 3.1.1), the program will use a character
with the 0Ah hexadecimal code that is equal to the "LF" ASCII code.

4.6.2.2 Date/time configuration

This group of options (fig. 3.2.1) allows you to configure how data and time stamps appear in the log
file and on the screen. You can configure the stamp format in the program options .

Fig. 3.2.1 Time stamp configuration

Add to display output for data sent - the time stamp will be added for the sent data displayed on
the screen. The stamp will be added according to the timeout (if the data flow is uninterrupted) or
when a data packet is sent.

Add to display output for data received - the same but for the received data.

Add if data direction has been changed - if the program is sending and receiving data, the time

34
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stamp will be also added when the data transfer direction changes (sending/receiving).

Add for data packets - if the data is displayed after it is processed, the stamp will be added to
each processed data packet.

Add at begin of file - the stamp will be added at the beginning of every new log file.

Stamp timeout - if the data flow is uninterrupted, the stamp will be added regularly at the interval
specified in milliseconds.

File prefix/postfix character(s) - the program will use these characters instead of those specified
in the program options  while writing data to a file. For example, it allows you to add the new line
character or another sequence of characters before or after the stamp. Example: >#0D#0A

4.6.2.3 Name and security

This group of options (fig. 3.3.1) allows you to configure the following parameters:

Friendly name - this name will be added before the port number or the data source in the drop-
down list in the main window of the program. It allows you to describe the data source.

Start logging automatically - if this option is enabled, the program will start receiving and logging
data automatically when it is launched.

The "Security" option group allows you to protect user operations in this particular configuration with
a password. You can specify advanced security options applied to the entire program in the program
options .

Ask password before start and stop - the password will be required when the user clicks the
"Start/Pause" button in the main window of the program.

Ask password before configuration edit - the password will be required when the user tries to
open the Configuration options dialog box.

34
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Fig. 3.3.1. Name and security
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4.6.3 Log files
4.6.3.1 Log rotation

The main function of Log Monitor & Export is logging data to a file (so-called, log file). The "Log
rotation" tab has a rich set of options for it. (fig. 4.1.1).

Fig. 4.1.1 Log-file forming modes

Set the "Create log file on disk" option to checked state. Then you can set path to folder, where files
will be created with the help of dialog window, which will be showed up after clicking a button with
picture of opening folder. You should select a necessary folder in the dialog window and click the
"OK" button. 

Note: The program can work with network paths too, but in this mode, the program will increase
data flow over a network and can be failed with exceptional errors.

A log file name can be stamped with date and time. In this case a new log file is created
periodically. The time stamp format depends on the selected period. For instance, if the "File name
prefix" field is set to "sample", the "File extension" field to "log" and the "File name format"
option is "Daily", then each log file created will have the format "sampleYYYYMMDD.log". On March
21st, 2003, the log file will be "sample20030321.log". Please, note, that the final extension (after the
final period), remains at the end of the file name. 
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Log rotation mode is defined by the following key parameters:

File name prefix - text string, which will be added at file name beginning;
File name extension - text string, which will be a file extension (characters after dot); 

Limit size - the "Limit size" field specify the maximum size in kilobytes of any log file. If you'll
specify zero size, then the file size will not limited. You may select from the following modes:
1. Clear file - if the log file size will exceed the limit specified, then the log file content will be

deleted and file filling will start from beginning.
2. Rename old - if the log file size will exceed the limit specified then the existing log file will be

renamed.
3. Shift (no threshold)  - the older data over the limit specified will removed from the log file.
4. Shift (with threshold). In this mode the program will wait when the file size will exceed the limit

specified + the threshold value. After this, the older data over the limit specified will removed from
the log file.

If the program works continuous for a long time, it is possible that the log file will have large size and
this file will be inconvenient for looking and analysing. For this there is the possibility to create files
in dependence with the time on PC. You can select one variant predefined or set up new one:

Daily - file will be created with name containing prefix, and date in format DDMMYYYY, where
DD is two-digit day sign, MM is two-digit month sign and YYYY is four digits of the current year.
The file name extension will be added at the end of file;
Monthly - file will be created with name containing prefix, and date in MMYYYY  format. The file
name extension will be added at the end of file;
Each data packet in different file - in this mode the program splits data flow to a different file.
In this mode you should configure the parser or the program will split a data by timeout about
300 ms.
Don't create new file - in this mode the program will write all data to one file. It is
recommended for a small data flow. Otherwise your log file will be too big and a performance of
the program will fall down;
User's format -  file will be created with name containing prefix and date in showed by you
format (for example, DDMMYYYY). The file name extension will be added at the end of file. The
file may not contain format signs, then file name will be constant. You should not use
characters, that the OS doesn't allows in file name, such as "/,\.*,?" and some others;
Weekly - create a new file every week. The file name will contains a week number;
After data timeout -  the program will create a new file if the program didn't receive any data at
the specified interval.
Hourly - file will be created with name containing prefix, and date in format YYYYMMDDHH,
where HH is two-digit hour sign, DD is two-digit day sign, MM is two-digit month sign and YYYY
is four digits of the current year. The file name extension will be added at the end of file;
Constantly named file - the current log file will have a constant name. When creating a new
file the existing log file will be saved using the new file name that will contain a data and time
stamp. 

Date and time formatting codes:

d - day, not adding null(1-31).
dd - day ,adding null(01-31).
ddd - day of the week in text form(Mon-Sat) according to standard, set on this computer.
dddd - day of the week in full text form(Monday-Saturday) according to standard, set on this
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computer.
m - month, not adding null(1-12).
mm - month, adding null (01-12).
mmm  - month in text form(Jan-Dec) according to standard, set on this computer.
mmmm - month in full text form (January- December) according to standard, set on this computer.
yy - year in the form of two last digits(00-99)
yyyy - year in the form of four last digits (0000-9999).
h - hours, not adding null (0-23).
hh - hours, adding null (00-23).
n - minutes, not adding null (0-59)
nn - minutes, adding null (00-59).
s - seconds, not adding null (0-59).
ss - seconds, adding null (00-59).

Example: you want to create log file every hour. It is desired that file name starts from "sample_log"
and the file extension "txt".

Answer: set file prefix = sample_log_, file extension= txt (without dot!). In file name format show
HHDDMMYYYY. Now file will be created every hour. Naturally, you can set any formatting
characters combination, described higher.

If you want to access to a log file while the program work, then you should configure access mode
settings  for the log file in the next chapter. 

Add date/time stamp to file name - this option is available for modes #4 and #7 and allows to add
date and time to the file name.

Add data source ID to file name - if this options is activated then then the program will append the
data source name at the beginning of the file name. For example, COM1-sample20030321.log.

Write data/time stamp to file before writing data - if this options is activated then then the
program will write a date/time stamp to a file before each data portion.

Overwrite existing files - this option is available for modes #4 and #7 and allows to delete an
existing log file before creating a new log file.

4.6.3.2 Log file access

During work can be such situations, when it is necessary to get access to a file with current data
(current log file) from other applications (for example, for data processing). But while you are
accessing the current log file Log Monitor & Export can't write data to a log file and all data at this
moment will be lost. We recommend to use a temporary file for data storage. It is most safe way.
(fig. 4.2.1).
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Fig. 4.2.1 File access mode.

You can select one from following variants:

Ignore and not write - with this mode, the data will be lost;
Write to a temporary file, then append - a temporary file will be created, to which writing will
be done. After access to current file will be got, temporary file content will be added to the end
of main file. But mind that if file is created in dependence of time, there can be a situation when
at temporary file forming name of the main file will be changed. Then temporary file will be added
to the end of newly created file.
Display a message and stop work - data will be lost until dialog window is closed.

You can set up your message text, which will be displayed at writing error to data file. The sound
signal can be on for an additional indication. You can also enable writing a message to a protocol
file.

4.6.3.3 Log deletion

The deletion of files (fig. 4.3.1) will help you to avoid stuffing your hard disk with needless
information. Log files can be deleted either depending on the time of storing or when the maximal
number of files is exceeded.
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When deleting files by the time of their storage, the files that were modified last time before the
specified period are deleted.

When controlling the number of files, the files with the oldest modification dates are deleted first.

You can select both variants of file deletion. In that case files will be deleted when either of the
conditions is true.

Fig. 4.3.1 Log deletion

4.6.4 Modules
4.6.4.1 Introduction & setup

To extend program functionality we implemented plug-ins modules. Module structure lets reduce
your program size and purchase costs (you pay only functionality, which you need), to low down
program distributive download time, your computer processor load and reduce disk space.

Log Monitor & Export supports few types of modules (fig. 5.1.1 - 5.1.3):

Data parser - data parser that allows you to parse, filter and format more complex data from
more sophisticated devices. Some of the advanced features of the parser are the ability to
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work with raw binary or hex data;
Data filter - data filters allow you to filter your data and modify values of parser variables;
Data export (fig.11) - Log Monitor & Export has many modules for passing serial data
directly to other applications, such as as keystrokes where incoming data is passed to other
programs as a sequence of keys, as DDE Server  that passes data to other programs using
Dynamic Data Exchange, ODBC for exporting data to a database and many others;
Events handling (fig.12) -  an external plug-ins used to handle events generated by the Log
Monitor & Export software. Once an event occurs (for example: "Data source is opened" or
"Configuration changed"), the plug-in creates a text message using the specified template
and sends a notification, do some actions, such as execute programs, scripts and etc. The
form of the notification or actions depends on the plug-in settings.

Fig. 5.1.1. Activating plug-ins
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Fig. 5.1.2 Activating data export plug-ins
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Fig. 5.1.3 Activating events handling plug-ins

Installation

You can easily install a new module. usually, you should start the installation file and click the
"Next" button for few times. The installation wizard will detect a place of your Log Monitor & Export
software and place a plug-in module and all distributive files to the "Plugins" folder, which is in the
program folder (by default X:\\Program Files\Log Monitor & Export\Plugins). 

After program restart a module will be loaded and initialized. If module is supported with our
software,  its short description you will see in modules list (Fig. 5.1.1-5.1.3). Most modules require
additional settings. If you want to configure the plug-in module, simply click the "Setup" button near
it. If you selected the module and the "Setup" button is not active, then module doesn't have
additional settings and can work without additional settings. Please, read users manual of a
corresponding plug-in for additional information.

Configuration steps

1. Select and configure a query module. You may use a module of this type if you need to send
some data to your device (for example, initialization strings or request strings).

2. Select and configure a parser module. This step is necessary, because filter and export modules
can use parsed data only. If you didn't select the parser module, then you can't configure the data
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filter and data export modules.
3. Activate and configure data export modules. You can select one or more modules simultaneously.

The program will use selected modules simultaneously. Please, note, the program can' use the
data export module, if you didn't configure the parser module.

4. Activate and configure event modules. You can select one or more modules simultaneously.

4.6.4.2 OPC server

Since the version 2.1.1 Log Monitor & Export has an internal OPC server. It means, that any OPC
compatible client application can get data from Log Monitor & Export without any additional
software. For connecting to the OPC server our OPC server has an unique attributes (Fig. 5.2.1).
Before using the OPC server on your PC you should download and install the OPC Core
Components Redistributable from www.opcfoundation.org (registration required).

Fig. 5.2.1 OPC server parameters

Log Monitor & Export are parsing all incoming data to one or more variables and OPC client are
getting it (fig. 5.2.2). After connecting to the OPC server you will get list of all variables.

http://www.opcfoundation.org
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Fig. 5.2.2 OPC server active items

Clients activity is showed on the "Active clients" tab. The top node is client, below is group of items
and connected items. By double-clicking, you can get a detailed information about each node.
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Fig. 5.2.3 OPC server clients

Log Monitor & Export creates new variables at "on-the-fly" mode. The Log Monitor & Export starts
without any variables and get it only after first data had been received. If your client OPC will connect
to the OPC server before, than data had been processed, then it will get empty list of variables and
your OPC client should poll the OPC server for updating list of variables. If your OPC client doesn't
allow it, then your can pre-define all variables (fig.5.2.4). In this case the OPC server will create
these variables with empty values, immediate after starting and your OPC client will get these
names while connecting.
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Fig. 5.2.4 OPC server pre-declaration

4.7 Program options

4.7.1 Window view

This tab in program options (fig. 6.1.1) allows you to customize appearance of the main window of
the program (fig.1.1.1 ). You can access this tab through the "Options -> Program options" menu
item in the main window.

5
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Fig. 6.1.1 Window view setting

You can set following parameters: 

Start in minimized state - at start Log Monitor & Export will automatically put its icon on
panel near clock (SysTray fig. 6.1.2);
Minimize to SysTray - while the main window of Log Monitor & Export minimizes, the program
will automatically put its icon to the panel near clock;
Show data window - if you specify this option, then the program will display all data in the
main window. If you are logging many ports on slow PC, then you can  computer CPU load rate
with disabling of this option;
Output data on screen in minimized state - if you'll enable this option, then the program will
display processed data in minimized state. If you are logging many data sources on slow PC,
then you can decrease computer central processor load rate with disabling of this option;
Font type - the data will be displayed with this font type in the main window only. We
recommend to use mono-spaced fonts in this field, such as: Terminal, Courier etc.;
Screen buffer - at exceeding of value specified the data window will be cleaned;
Window view - will let you setup data window view (font color, font type, background color).
Transparency - in Windows 2000 and later will let you set transparency of the main window.
The most left position is normal window view and most right position is maximum transparency.
Wrap words - if you didn't configure a parser module or your data flow doesn't contain a blocks
separator, then your data without this option enabled will be displayed as one long string in the
data window.
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Fig. 6.1.2 Systray - panel near clock

4.7.2 Date/time stamp view

This group of options (fig. 6.2.1) allows to configure the format of date/time stamps that will be used
in the main program window and log files.

Fig. 6.2.1 Configuring data/stamp view

Prefix/Postfix characters for display output - these options allow to define beginning and ending
characters of a date/time stamp that will be showed in the program window. When outputting data to
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a log file the program uses individual characters  for each configuration.

View mode - allows to select the standard or define the custom format of the date/time stamp.

Font - this group allows to define the color and font of date/time stamp.

Add data direction sign to a stamp - if this option is activated then the program will append TX or
RX to the end of the stamp.

Add data source ID to a stamp - if this option is activated then the program will data append data
source ID at the beginning of the stamp. For example, COM1.

4.7.3 Protocol and errors handling

While the program execute, she generates many messages about errors and events. All these
messages are being registered in a protocol file. This can be start or stop of the program, some
messages from plug-in modules etc. On this tab you can define the kind of messages, which you
want to put a protocol file (fig. 6.3.1). Here you can set maximum protocol file size and a formatting
mode. Usually, the protocol file is in a program folder and has the name of the program with the 'log'
extension.

18
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Fig. 6.3.1 Protocol settings

Log Monitor & Export works with three types of messages:

Information messages - this type of messages informs you on operations which are fulfilled in
the current time;
Warnings - warns you of possible failures or possible errors. Interference of the user is not
required, but check is required;
Errors - the program has detected an error which elimination needs involvement of the user.

There is the possibility to log following events:

Program messages - messages about start or stop of the program, etc.;
Data query - messages which are generated in a data query module;
Data parser - messages which are generated in a data parser module;
Data export - messages which are generated in a data export module;
Other - messages that can not be associated with types above.

You can write each type of messages to a protocol file or/and to the list in the main window. Please,
specify necessary options for each message type at "Window" and "File" fields.

If you don't want to allow to grow a protocol file size to an unlimited size, then you can enable the
"Clean protocol at program start" or limit protocol file size in the "Size" field.

Some exceptional messages can occur while the program execute. In most cases these messages
crash the program and the most safe way is to restart the program. Please, specify the "Restart
program at exception" option and the program will be restarted automatically.

If you want look all program messages, then you can disable the "Don't display messages at
unhandled exceptions" check box and the program will open the exception message window with
detailed information.

4.7.4 Service mode on Windows 2000+
4.7.4.1 Configuration

Windows NT+ services use will let you:

control service on local and remote computers, including remote computers with Windows NT
4.0 system;
setup actions on emergency service restore in case of failure, for example auto service or
computer restart (only on computers with Windows 2000 or later);
create for services other names and descriptions, to find them easier (only on computers with
system Windows 2000 or later); 
run service before user login (password input);  
service can be setup on automatic start after operation system load.

Note 1: you must be logged in as an administrator in order to change the configuration or control the
service in any way (start, stop, pause, continue).

Note 2: On Windows Vista and later you should start the program with elevated administrator
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privileges.

If you want to use the program as a service application, then, please, go to the "Options -> Program
options -> Windows service" tab (fig. 6.4.1), then enable the "Use program as a service" check box.
Later, please, specify the startup type of the service. There can be following variants:

Fig. 6.4.1 Service settings

1. Automatic - service will be started automatically at every Windows start, before user login;
2. Manual - you can start the service application in the "Services" window in the Control panel (fig.

6.4.2);
3. Disabled - service can't be started.

If you want to change program settings while service mode, then enable the "Allow service to interact
with desktop" option. In this case, the program will put the icon to the SysTray (fig. 6.4.2). But then
your interactive service will be restarted while user log off.
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Fig. 6.4.2 Service icon in Systray

If you use data bases or special drivers, before service run, these applications must be run. You can
specify what services should be started before Log Monitor & Export in the "Program depends on
services" window (fig. 6.4.3). 

Fig. 6.4.3 Service settings #2

In some case you need to start Log Monitor & Export before starting other services. In this case you
should:

Switch a start mode of a target service to "Manual";
Start Log Monitor & Export;
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Set on the target service at the "Services depend on ASDL" tab;
Select mode when you need start these service;
Restart Log Monitor & Export.

After you installed the service mode of the program, restart a computer or run the service manually
from the "Services" window in the Control panel (fig. 6.4.4)
 

Fig. 6.4.4 Manual service run (in Windows 2000)

After start of the service, the service processes names will be displayed in a process list:
logmonitorsrv.exe and logmonitor.exe (fig. 6.4.5). The 'logmonitorsrv.exe' application makes interface
between the service manager and the Log Monitor & Export software. Unlike srvany.exe utility, our
service stops safely.
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Fig. 6.4.5 Process list

If you want to configure the program as a service, then you must be logged with administrator rights.
The service application can be controlled, stopped or removed with help of a command line string.
Run logmonitorsrv.exe with following parameters:

/? - short help;
/I - install service for start in manual mode;
/A - install service for start in automatic mode;
/D - install service in off state;
/R - remove service from computer.

4.7.4.2 Windows Vista+ notes

One of the ways Vista's security was improved was by separating system services and user
applications into separate 'sessions'. Keeping the system services isolated helps to better secure
them, but also makes any interactive interface unavailable to the user. That's where the Interactive
Services Detection service comes in. When a service needs to interact with the user, Interactive
Services Detection presents a dialog that will switch the user to the session where the service is
running so they can interact with the service. For an excellent, detailed description of this, see next
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paragraph.

Many sites recommend disabling this service, but doing so will result in you not being able to
interact with any services that require your attention. This service is run manually by default, so
there is little point to disabling it unless you don't want to be bothered by important information from
the software you may be trying to run.

Display Name: Interactive Services Detection
Service Name: UI0Detect
Process Name: UI0Detect.exe
Description: Enables user notification of user input for interactive services, which enables access
to dialogs created by interactive services when they appear. If this service is stopped, notifications
of new interactive service dialogs will no longer function and there may no longer be access to
interactive service dialogs. If this service is disabled, both notifications of and access to new
interactive service dialogs will no longer function.
Path to Executable: %windir%\system32\UI0Detect.exe
Default Startup:

    * Home Basic: Manual
    * Home Premium: Manual
    * Business: Manual
    * Enterprise: Manual
    * Ultimate: Manual

4.7.5 Restart & Security

Sometimes the program should be restarted. For example, if you've changed the program settings
remotely and want to reload program automatically with the new settings. To do that, specify the
time for restarting the program on the "Restart & Security" tab in program options "Options-
>Program options". Just specify the time of day, when the program should be being restarted.
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Fig. 6.5.1 Program restart settings

On this tab you can also protect some actions with the program by a password. To do that, activate
the "Protect by password" option, define a password and select protectable actions.

5 Having problems?

5.1 Program doesn't run or work

It is necessary to make sure in proper time installation on your computer, so as if you put clock after
program installation, protection from use after trial period works. 

Also program won't work, if you started Softlce application debug environment or some other. In any
other case, please, inform our developers about your problems, our address support@aggsoft.com.

mailto:support@aggsoft.com
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